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Welcome to Wizcon, a Supervisory Control and Data Acquisition
(SCADA) system used as an applications development tool that allows
system integrators to create sophisticated process control applications for a
variety of industries.

In this guide, we will show you a working application of a plant. You will
interact with the application and familiarize yourself with Wizcon. Then,
we will step you through a tutorial in which you will complete an
unfinished version of the same application.

If you are a new user, this guide will familiarize you with Wizcon. If you
are already familiar with Wizcon, this guide will introduce you to the new
Wizcon interface.

 The workflow for this getting started guide is as follows :

■ Install Wizcon, as described on the following page.

■ Open a working application, as described on page 8.

■ View and interact with a working application of a plant, as described
on page 13.

■ Look at the unfinished application upon which this tutorial is based,
and follow the steps provided to complete it, as described on
page 22.
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/HW·V�,QVWDOO�:L]FRQ

This section describes Wizcon system requirements and the installation
procedure.

6\VWHP�5HTXLUHPHQWV
Before you install Wizcon, verify that you have the following:

Computer: 200MHz Pentium, or higher.

Memory: 64MB minimum.

Hard Disk: 120 MB minimum free.

Display: VGA, SVGA, or any graphic adaptor that supports the operating
system desktop. The display should be set at 256 colors or higher and the
screen resolution should be set at 640 x 480 or higher.

Mouse: Any PC compatible mouse.

Parallel Port: Required for the Wizcon security plug.

Operating System: Microsoft’s Windows NT version 4.0 (or higher) or
Microsoft’s Windows 95,98.

Network: Windows 95/98 NetBEUI Protocol. Or a properly configured
TCP/IP. If using Novell network, IPX/SPX compatible protocol is required.

You may need other add-on adaptors, such as network controllers, for
specific installations.

,QVWDOOLQJ�:L]FRQ

It is strongly recommended that you close and exit all Windows programs
before running the Setup. If you are upgrading from a former Wizcon
version, press Ctrl + Alt + Delete to make sure that WizPro is not running
in the background.
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➤ To install Wizcon:

1. Insert the CD-ROM into the CD drive, Windows automatically loads
and runs the Setup program. The CD-ROM has an Autorun Setup
program. The WizFactory Setup program is displayed:

 Or

 If your Windows is not configured for Autorun you will need to run
the Master Setup yourself. Click on the Start button, select Run and
enter: D:\setup.exe into the Open field (where D is your CD-
ROM drive). Click OK.

 

 

2. Select Wizcon for Windows and Internet from the WizFactory Setup
CD to load the setup program for Wizcon. The following dialog is
displayed:
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3. Click on the Next button to continue the installation. The following
dialog is displayed in which you can choose the directory in which
Wizcon for Internet will be installed:

 

4. If you have a previous version of Wizcon installed, you are prompted
to overwrite the previous version or to Exit the installation, in the
following note:
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 It is recommended to click Yes to overwrite the previous
installation.

5. Click the Next button to install Wizcon in the default folder:
(C:\WizFactory\Wizcon). Click the Browse button if you want to
change the default directory.

6. Click the Next button and the Select Components dialog is
displayed:

 

In this dialog, you can select the following components for installation:



���*HWWLQJ�6WDUWHG

System Files: Select this option to install the Wizcon for Windows and
Internet application files in the directory specified in the Destination
Directory field in this dialog. The default directory is
C:\WizFactory\Wizcon.

Communication Drivers (Optional): Select this option if you are using
an external driver or controller. You can then select the drivers you
want to install from a list of existing Wizcon device drivers. Press the
Change button to open another dialog where you select the drivers you
wish to install.
The dialog specifies the default directory in which Wizcon will be
installed.

Getting Started - Web: Select this option to install the Wizcon for
Internet Getting Started tutorials (Exercise and Final applications).

Getting Started - Windows: Select this option to install the Wizcon for
Windows Getting Started tutorials (Exercise and Final applications).

It is recommended to select the Wizcon System files option. Click the
Next button. The Select a Language dialog is displayed:
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Please note that you will not receive the Select Language dialog if you
did not Check (á) the System files.

7. Choose one of the languages that you want to install. Wizcon is
localized for English, French, German, Chinese, Japanese, and
Polish.

8. Press the Next button. A progress bar is displayed and the
installation begins. When installation is complete the Finish Reboot
dialog is displayed. Click Yes to restart your PC or click No to
update later. It is recommended to restart your PC immediately after
installation.

 

9. Click Finish. Installation is complete.

1RZ�\RX�ZLOO�RSHQ�D�ZRUNLQJ�DSSOLFDWLRQ��FDOOHG�)LQDO�$SSOLFDWLRQ��)LQDO
([HUFLVH��



���*HWWLQJ�6WDUWHG

/HW·V�2SHQ�WKH�)LQDO�$SSOLFDWLRQ

Now you will interact with a working application so that you can
familiarize yourself with Wizcon. This involves the following steps:

■ Open the final application, as described below.

■ View the Wizcon Application Studio, as described on page 10.

2SHQLQJ�WKH�)LQDO�$SSOLFDWLRQ

When you open the final application the following is displayed:

■ A Tip of the Day window, as described on the following page.

■ The Wizcon Quick Access bar: from which you can quickly access
different parts of an application. In this Getting Started guide you
will use this bar to open the Wizcon Application Studio, the
operational framework of Wizcon, and to exit Wizcon only.

■ An Image: a graphical representation of the process with which you
will interact, as described on page 13.
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➤ To open the final application:

1. Click the Start button and then point to Programs. From the
displayed menu, point to WizFactory, point to Wizcon, and then
Getting Started for Windows. From the displayed menu, click on
Final Application (Final Exercise).

 

Tip of the Day
 window

Image

Wizcon Quick 
Access bar

2. The Tip of the Day window, in which you can view Wizcon tips, is
displayed over the image and the Wizcon Quick Access bar. Click
Next Tip to display the next tip, or click Close to close this window.

3. The image is now displayed together with the Wizcon Quick Access
bar. We shall look at the image afterward, so click the Minimize
button in the top right corner of the image to minimize it.
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The Wizcon Quick Access bar is displayed on your desktop:

 

4. Click on the Wizcon Application Studio  button to display the
Wizcon Application Studio.

7KH�:L]FRQ�$SSOLFDWLRQ�6WXGLR

The Wizcon Application Studio is displayed, as shown below:

The Wizcon Application Studio is used to create a Wizcon application.
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It is divided into two frames:

■ All Containers tree on the left: displays a hierarchical structure of the
containers from which you build a Wizcon application. Containers
can be thought of as the building blocks of a Wizcon application.
The tree is made up of two main groups: files and objects. Each item
is a collection of objects or files.

■ Control Panel on the right: from which you change the settings of
the application, such as printer settings and user setups, and activate
utilities like single Tag Simulation. The Control Panel is displayed
when the initial container is selected, in this case
GettingStartedFinal which is the name of this application.

If a container is selected on the left, a list of the items of the same
type is displayed on the right. For example when Alarms is selected
in the All Containers list, a list of all the tags currently defined with
alarms in the application is displayed in the List of Alarms.
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The Application Studio also contains:

■ A menu bar through which you can access Wizcon operational
menus.

■ A toolbar that enables quick access to Wizcon Application Studio’s
most frequently used functions.

1RZ�\RX�ZLOO�ORRN�DW�WKH�DSSOLFDWLRQ�LPDJH�
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/HW·V�/RRN�DW�WKH�$SSOLFDWLRQ�,PDJH

Wizcon enables process monitoring through various visual options. One of
the most interesting of these is the Wizcon image, that shows a graphical
representation of a process.

The image shown on the following page depicts a process in a chemical
plant that is controlled and supervised through Wizcon. It was drawn using
the Wizcon extensive graphic editor and clusters library.

First we will look at the image and show you some of the interesting
features of a completed application. Then, we will help you open an
unfinished version of this application and walk you through the process of
completing it.
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➤ To view the image:

Click on the My First  button in the task bar at the
bottom of your screen. The image of the final application is displayed:

Let’s take a look at the objects in this image:

A storage tank that contains raw material.

A pump and a valve that control the raw material output from the
storage tank to the reactor.
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A reactor to which the raw material from the storage tank is
pumped. It is then mixed and heated to a specified temperature.

A valve that controls the output from the reactor to the output
tank.

An output tank to which the mixed material is discharged from
the reactor.

A truck into which the mixed material is loaded at the end of the
process.

A button which can be pressed to display an application menu
through which you can access additional features of the
application.

1RZ��OHW·V�LQWHUDFW�ZLWK�WKLV�LPDJH�WR�VHH�KRZ�RXU�SODQW�SURFHVV�FDQ
EH�PRQLWRUHG�DQG�FRQWUROOHG�

Click on the pump. Notice how its red button changes to green.

 Click on the Valve_In. Notice how its handle turns from red to green
and swivels from right to left. The storage tank then starts emptying
its raw material and the reactor starts to fill. The material is mixed in
the reactor.
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When the reactor is full, the following window is displayed:

This window displays two alarms notifying you of high temperatures
in the reactor. An alarm is a Wizcon alarm that defines abnormal or
extreme conditions in a plant. In this tutorial, there is no need to
acknowledge these conditions, although an operator in a real plant
would usually do so. Click Clear All to clear the alarms.

The window closes, and the alarms are stored by the application in a
historical file. Another way to view alarms is through an Events
Summary window described in Step 9.

At this point, the reactor is full, the storage tank is one quarter empty.
The pump and Valve_In are open.

 Click on the Valve_Out in order to empty the reactor of the material.
Notice how its handle turns from red to green. The Tank_Out fills
and the storage tank continues to empty.

When the Tank_Out is full, the Valve_Out closes. Notice how its
handle changes from green to red.
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Click on the truck to empty the Tank_Out. The material pours out of
the Tank_Out and into the truck. When the Tank_Out is completely
empty the truck moves to its destination on the other side of the
image.

When the truck reaches its destination, it returns to its starting point.

 Click the Menu button on the bottom left side of the image. The
following menu is displayed:

This menu contains the following buttons:

■ Chart, described on the following page.

■ Events Summary, described on the following page.

■ Input zone, described on page 19.

■ Help, described on page 20.

■ Cancel, that closes the menu.
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&KDUW

Click Chart to display a graphical view of the process behavior and
operational trend of the storage tank.

(YHQWV�6XPPDU\

Click Events Summary to display a window in which you can handle and
classify alarms. For example, the Events Summary below displays a list of
the alarms “encountered” in the Getting Started application since you
started this tutorial.
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,QSXW�=RQH

A zone is an area of the image that can be viewed in close-up. Wizcon
enables you to section off parts of an image, and then zoom in (view) one
particular part.

Click INPUT ZONE to zoom to the part of the image that represents the
input process, as displayed below. You have now accessed a different layer
(a specific section) in the image, in which you can view additional
information.

Notice the text displays next to the storage tank and the reactor representing
the quantity of the material inside them.

These displays are dynamic, meaning that if you access (display) this zone
while the application is running, their displayed value will change
according to the actual current quantity of material in the storage tank and
in the reactor.
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Notice the text displays next to the pump, the Valve_In and the Valve_Out.
These too are dynamic displays:

■ Click the pump to operate it. Notice how the red button turns to
green, and the text display changes from Stop to Run.

■ Click Valve_In to open it. Notice how the handle swivels from right
to left and turns from red to green. Notice too how the text display
changes from Close to Open.

Click on the Pump and the Valve_In to close them.

 Click on the menu button on the bottom left side of the image
to display the entire image.

+HOS

Click Help to show a help topic about this menu.

:H�KDYH�ILQLVKHG�ORRNLQJ�DW�WKLV�DSSOLFDWLRQ��/HW·V�FORVH�WKLV
DSSOLFDWLRQ�DQG�RSHQ�WKH�XQILQLVKHG�YHUVLRQ�RI�WKLV�DSSOLFDWLRQ�XSRQ
ZKLFK�WKH�WXWRULDO�LV�EDVHG��DV�GHVFULEHG�LQ�WKH�IROORZLQJ�SDJHV�
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&ORVLQJ�WKH�$SSOLFDWLRQ

You have interacted with a demo Wizcon application. You are now going to
close this application. In the next step you will open the unfinished version
of this application, and throughout the remainder of the tutorial complete it
to achieve this final result.

➤ To close the application:

1. Click on the Wizcon User name  button in the taskbar at the
bottom of your screen to display the Wizcon Quick Access bar.

2. Click the Exit  button, on far right of the bar. Wizcon closes.
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%XLOGLQJ�$Q�$SSOLFDWLRQ

In this section you will view an unfinished image of this application. This
image represents an unfinished version of the application presented on
pages 13 through 20, and is the application upon which this tutorial is
based.

➤ To open the application:

1. Click the Start button and then point to Programs. From the
displayed menu, point to WizFactory, point to Wizcon and then to
Getting Started for Windows. From the displayed menu, click on
Exercise Application (Tutor Exercise). The unfinished application
is displayed.

2. In the Tip of the Day window, click Close. The image and the
Wizcon Quick Access bar are displayed.

3. Click anywhere on the image, the Wizcon Quick Access bar is
hidden. It can be accessed later through the taskbar. The following
image is displayed:
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Notice that the following objects are missing:

The reactor

The output tank

The truck

The piping

The menu button

➤ This tutorial is divided into the following steps:

Step 1, page 25, defines a tag, an internal variable, to indicate the truck’s
movement.

Step 2, page 29, defines an alarm that will display when the level of
material in the storage tank is too low.

Step 3, page 31, completes the image by:

■ Inserting the parts of the application that are missing in the image
from the clusters library:

• The reactor

• The output tank

• The truck

■ Drawing the piping that connects the objects.

Step 4, page 42, defines dynamics for the truck to make it move when it has
filled with material from the storage tank.

Step 5, page 48, defines a section of the image as a zone so that it can be
viewed close-up and adds a layer to the image.
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Step 6, page 56, creates dynamic text displays that represent the level of
material in the storage tank and the reactor, the pump running and stopping,
and the valves opening and closing.

Step 7, page 66, creates a button, called a trigger, in a zoomed section of
the image which can be clicked to display the entire image.

Step 8, page 70, defines a chart window to display a graphical plot of the
levels of material in the reactor during the application process.

Step 9, page 74, defines an Events Summary window to display alarms.

Step 10, page 76, defines macros to launch the chart window and the
Events Summary window defined in Steps 8 and 9.

Step 11, page 80, creates an Application menu so that you can access
different parts of the application, such as the chart window and the Events
Summary window defined in Steps 8 and 9, and the zone defined in Step 5.

Step 12, page 86, describes how to interact with your application.

Step 13, page 87, describes how to save your application and how to exit
Wizcon.
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6WHS����'HILQLQJ�D�7DJ

A Wizcon tag is used as an internal variable for:

■ Calculations and display.

■ Communication with PLCs (Programmable Language Controllers) in
order to represent data from PLC memory or to send commands to
PLCs.

There are three types of tags: PLC, Dummy, and Compound:

PLC: A PLC Tag represents data from a PLC memory. Each PLC tag is
associated with a specific PLC register, defined as Tag address in Wizcon
tag definition. The format of a tag address varies from one PLC to another
and depends on the PLC memory structure, internal architecture and
communication protocol. When exchanging data between Wizcon tags and
PLCs, the communication driver for the specific PLC should be installed.

Dummy: A dummy tag represents internal variables that are not connected
to the field devices. Dummy tags are used for various calculations or
internal processing. We will use a dummy tag in our tutorial.

Compound: A compound tag is a tag whose value is calculated from a
linear combination of the two other tags.

PLC and Dummy tags can be one of the following types:

■ Analog: that represent numeric values, such as integers, longs and
floats.

■ Digital: that represent discrete logic states.

■ String: that represent textual data.

In this Getting Started application, a communication driver has been
installed that simulates input to and output from the field devices, such as
the storage tank and truck.
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,Q�WKH�QH[W�VHFWLRQ�\RX�ZLOO�GHILQH�D�WDJ�WR�LQGLFDWH�WKH�WUXFN·V
PRYHPHQW�

'HILQLQJ�D�7DJ�IRU�WKH�7UXFN

You will now define a dummy tag that will be used to indicate the truck’s
movement. This is done in the Wizcon Application Studio. Since this is the
first time you are accessing the Application Studio, you must first open it
through the Wizcon Quick Access bar.

➤ To define a tag:

1. Minimize the image by clicking the Minimize  button in its top
right corner in order to get a clear view of the Wizcon Application
Studio and the dialogs in which you will define the tag.

2. Click on the Wizcon User name  button in
the task bar at the bottom of your screen to display the Wizcon
Quick Access bar:

 

3. Click the Wizcon Application Studio  button. The Wizcon
Application Studio is displayed, as shown on page 10.

If the Application Studio is not displayed it may be hidden behind
another window. Press the Alt and Tab keys simultaneously to view it.

4. From the All Containers section of the Wizcon Application Studio,
right-click Tags and select Add Tag from the displayed pop-up
menu.
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The Tag Definition: New Tag dialog is displayed:

 

5. In the Tag Name field enter MOVE_TRUCK.

6. In the Description field enter Truck Movement.

7. Click OK to confirm your definitions of the tag and to close the
dialog.

We have now defined a tag called MOVE_TRUCK that indicates the
truck’s movement. Default options determine that the tags source is a
dummy, meaning that the tag will be used for internal processing only.
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'LG�<RX�.QRZ
■ 8S�WR����FRPPXQLFDWLRQ�GULYHUV�FDQ�EH�LQVWDOOHG�RQ�RQH�:L]FRQ

VWDWLRQ�

■ (DFK�GULYHU�FDQ�EH�FRQQHFWHG�ZLWK�XS�WR�����3/&V��3URJUDPPDEOH
/DQJXDJH�&RQWUROOHUV��RQ�D�QHWZRUN�

■ (DFK�FRPPXQLFDWLRQ�GULYHU�UXQV�XQGHU�D�GHGLFDWHG�:LQGRZV
17�������WKUHDG�

■ $OO�GULYHUV�FRPPXQLFDWH�VLPXOWDQHRXVO\�ZLWK�3/&V�DQG�H[WHUQDO
GHYLFHV�

■ 7KH�WRWDO�QXPEHU�RI�WDJV�WKDW�FDQ�EH�GHILQHG�LQ�WKH�PD[LPXP
PRGHO�RI�:L]FRQ�LV���������,Q�WKLV�*HWWLQJ�6WDUWHG�DSSOLFDWLRQ
WKH�PD[LPXP�QXPEHU�RI�WDJV�WKDW�FDQ�EH�GHILQHG�LV�WHQ�

,Q�WKH�QH[W�VWHS�\RX�ZLOO�GHILQH�DQ�DODUP�WKDW�ZLOO�EH�GLVSOD\HG�LQ�DQ
(YHQWV�6XPPDU\�ZLQGRZ��D�:L]FRQ�DODUP�ZLQGRZ��ZKHQ�WKH�OHYHO�RI
UDZ�PDWHULDO�LQ�WKH�VWRUDJH�WDQN�LV�ORZ�
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6WHS����'HILQLQJ�DQ�$ODUP

Wizcon alarms are application messages used to notify operators about
exceptional conditions in the plant. They provide operators with
information concerning internal system events, such as communication
driver failure, network communication errors and so on.

Wizcon alarms are displayed in a special Wizcon window called an Events
Summary. They can also be displayed in a window that will pop-up when
the exceptional condition occurs. For example, the warning of high
temperature in the reactor that you viewed on page 16.

Operators can use the Events Summary to examine and handle numerous
alarms by filtering and sorting them.

In this section we will define an alarm that will be displayed when the level
of the raw material in the storage tank is too low.

➤ To define an alarm:

1. From the All Containers section of the Wizcon Application Studio,
right-click Alarms and select Add Alarm.
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The Alarm Definition: New Alarm dialog is displayed:

 

2. Click on the arrow to the right of the Tag Name field and select
STORAGE from the drop-down list.

3. Click on the arrow to the right of the Operator field and select <=.

4. In the Value field, enter 200.

5. In the Alarm Text field, enter Level in Storage is Low .
This is the message that will appear when the alarm is displayed.

6. In the Targets area, check Events Summary. The alarm will be
viewed in an Events Summary window.

7. Click OK to save your definitions and to close the dialog.

<RX�KDYH�GHILQHG�WKH�WDJV�DQG�DODUPV�IRU�\RXU�DSSOLFDWLRQ��,Q�WKH
QH[W�VWHS�\RX�ZLOO�EXLOG�WKH�DSSOLFDWLRQ�LPDJH�
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6WHS����%XLOGLQJ�WKH�$SSOLFDWLRQ�,PDJH

Now that you have defined tags and alarms for the application, you need to
build the application image. In order for this image to resemble the final
application, you need to add the reactor, the output tank, the truck and the
piping.

Unfinished Image Final Image

This step is made up of two parts:

■ Using the Wizcon clusters library to insert objects with pre-defined
behavior patterns, as described below.

■ Using Wizcon drawing tools to draw the piping, as described on
page 38.

7KH�&OXVWHUV�/LEUDU\

The Wizcon clusters library feature uses object oriented technology to
simplify and speed up application design and maintenance. A cluster is an
object-class with pre-defined behavior patterns that may include the
following:

■ The graphical shape of the object.

■ Tag and alarm definitions.
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■ Dynamics, meaning how the object is animated. It may move,
change color, fill and empty, and so on.

■ Triggers for user interaction. For example, clicking on a
trigger-defined object can change a tag value, activate a macro, and
so on.

Clusters can be placed in an application and used as needed. They can be
simple (such as circles or pumps), or complex (such as a small application
that includes, tanks, pumps and valves).

Working with clusters is much easier than working with graphics, tags and
alarms separately. Besides saving time, you can use an object that has been
already approved for work.

Wizcon comes with a rich set of cluster libraries that include a variety of
pre-built objects, such as control buttons, valves, pumps and other industry
standard components. We have developed a clusters library called FirstLib,
that contains the objects needed for this Getting Started application.

Once you place a cluster in your application, you create a single instance of
that object. Each cluster can have many different instances, each with the
specific characteristics, or properties, that you define according to your
application’s needs. For example, each instance can be associated with a
different set of tags and alarms that you define when creating a new
instance in the application. The action of creating a separate instance of the
object or function is called Instantiation.

,QVHUWLQJ�2EMHFWV�,QWR�WKH�,PDJH

In this section you will insert the reactor, the output tank and the truck from
the clusters library into the unfinished image of the application. Later, you
will use Wizcon drawing tools to draw in the piping that connects all the
objects in the image.
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This involves the following steps:

■ Accessing the unfinished image, described below.

■ Switching to edit mode so that you can edit the image, described
below.

■ Opening the clusters library and inserting the reactor, the output
tank, and the truck, described on page 34.

■ Using Wizcon drawing tools to draw the piping, described on
page 38.

$FFHVVLQJ�WKH�8QILQLVKHG�,PDJH

In this section you will open the unfinished image of the application upon
which this tutorial is based and familiarize yourself with it. Afterwards, you
will change its mode so that you can edit it.

➤ To access the unfinished image:

Click the MY_FIRST  button in the task bar at the bottom of
your screen to display the image.

6ZLWFKLQJ�WR�(GLW�0RGH

Now you will switch to edit mode so that you can edit the picture.
Afterwards, you will open the clusters library and insert objects.

➤ To switch to edit mode:

From the Modes menu of the image, select Edit. You can now edit the
image, as described on the following pages.
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You will now open the clusters library and insert the following objects from
the clusters library into the image:

■ The reactor

■ The output tank

■ The truck

After you have inserted the objects, you will move them to their correct
position.

➤ To insert objects from the clusters library:

1. From the Clusters menu of the image select Open lib. The following
dialog is displayed:
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2. Click on the drop-down box and select FIRSTLIB. This is the
library that contains the objects used in this Getting Started
application.

 

3. Right-click on the reactor, drag it out of the library dialog and drop it
on to the image. The Define Instance Link dialog is displayed:

 

 Notice the list of pre-defined dynamics that appear in the Linked
Tags and Alarms field.
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4. In the Instance Name field enter Reactor and click OK.

5. Click OK to save your settings and to close the dialog. The reactor
now appears in the image.

6. Right-click on the Tank_Out in the library and drag and drop it on to
the image. The Define Instance Link dialog is displayed, as shown
above. In the Instance Name field enter Output and click OK.

7. Right-click on the truck in the library and drag and drop it on to the
image. The Instance Parameters dialog is displayed.

 

8. In the Instance Name field enter Truck and click OK.

9. Click Exit to close the clusters library.
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Your image should now look like this:

5HSRVLWLRQLQJ�WKH�2EMHFWV�,QVHUWHG�IURP�WKH�&OXVWHUV�/LEUDU\

You will now reposition the reactor, the output tank and the truck so that
the image resembles the image of the final application. You may want to
look at the picture of the final application on page 14 to remind you of the
object’s position.

<RX�PD\�ILQG�LW�KHOSIXO�WR�GLVSOD\�WKH�GUDZLQJ�JULG��)URP�WKH�0RGHV
PHQX�LQ�WKH�LPDJH��VHOHFW�*ULGV�6KRZ�

➤ To reposition an object:

1. Click on an object to select it.

2. Click again and drag it to its new position.
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In this section you will draw the piping on the image using Wizcon drawing
tools. This involves the following steps:

■ Preparing the environment for drawing by displaying Wizcon
drawing toolboxes, as described below.

■ Selecting colors for the piping, as described on the following page.

■ Drawing the piping in sections, starting at the storage tank and
ending at the truck, as described on page 40.

:L]FRQ�7RROER[HV

Wizcon features many different toolboxes to enable you to build your
application. In this tutorial we shall use three of them.

➤ To display Wizcon toolboxes:

1. From the View menu of the image, select Objects, to display the
Objects toolbox.

2. From the View menu of the image, select Drawings, to display the
Drawings  toolbox.

3. From the View menu of the image, select Colors to display the Color
toolbox.
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The toolboxes are displayed on the image:
Colors toolbox

Drawings
toolbox

Objects
toolbox

,I�D�WRROER[�FRYHUV�DQ�REMHFW��\RX�PD\�ZDQW�WR�UHSRVLWLRQ�LW�E\
FOLFNLQJ�LWV�WLWOH�EDU�DQG�GUDJJLQJ�LW�WR�D�GLIIHUHQW�SRVLWLRQ�

6HOHFWLQJ�&RORUV�IRU�WKH�3LSLQJ

In this step you will select the colors of the piping from the Color toolbox;
red piping with a black outline.

➤ To select colors from the toolbox:

From the Color toolbox click on black and right-click on red.
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You will draw the piping in sections starting from the storage base of the
storage tank and ending at the truck.

You will draw each section of pipe from one point to another, as described
below.

■ Click once at the starting point and move the cursor to draw the
pipe.

■ Click again to move the cursor in another direction or if you have
reached the end point of pipe.

■ Right-click.

➤ To draw piping:

1. Select the Orthogonal Pipe  tool from the Drawings toolbox.

2. Click the base of the storage tank and slowly move the cursor down
to the inlet of the pump. Click, then right-click. Notice the pipe.

3. Click the outlet of the pump and move the cursor to the inlet of the
Valve_In. Click, then right-click.

4. Click the outlet of the Valve_In and move the cursor to the reactor.
Click, then right-click.

5. Click the base of the reactor and move the cursor down until it is in
line with the Valve_Out inlet. Click and move the cursor diagonally
across until it reaches the inlet of the Valve_Out. Click, then right-
click.

6. Click the outlet of the Valve_Out and move the cursor across until it
reaches the left side of the Tank_Out. Click, then right-click.

7. Click the right side of the Tank_Out and move the cursor diagonally
across the image until it is in line with the inlet of the truck.
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Click, then move the cursor down until it reaches the inlet of the
truck. Click, then right-click.

8. Right-click anywhere on the image to deselect the Orthogonal Pipe
tool. Your image should now resemble the image displayed on
page 14.

8VH�WKH�5HSDLQW�WRRO�WR�FOHDQ�XS��UHIUHVK��\RXU�LPDJH�E\�VHOHFWLQJ
5HSDLQW�IURP�WKH�2SWLRQV�PHQX�RU�E\�KROGLQJ�GRZQ�WKH�$OW�NH\�DQG
SUHVVLQJ�5�
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Dynamic objects are elements that are related to tags. When their tag value
changes, the visual properties of the object such as position and color,
change accordingly. In order to implement object animation, tag value
ranges are denoted by start and end values.

Most of the objects in the final image are dynamic. They have the following
dynamic behavior:

■ The button on the pump changes color when clicked indicating that
the pump is open or closed.

■ The handle on the Valve_In changes color when clicked and swivels
from right to left and vice-versa, indicating that the valve is open or
closed.

■ The handle on the Valve_Out changes color when clicked, indicating
that the pump is open or closed.

■ The storage tank fills.

■ The reactor empties.

■ The output tank fills and empties.

■ The truck moves.

In this Getting Started application, the dynamics for all objects except for
the truck, have been prepared for you in order to shorten the process of this
tutorial. In this section you will make the truck dynamic so that it will move
from one side of the image to the other when it has filled with material.

You inserted the truck into the image in the previous step. The truck was
inserted from the clusters library with its pre-defined behavior patterns. In
order to make a change to its attributes, such as making it dynamic, it first
has to be broken (disconnected), from the clusters library.
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This section involves the following steps:

 Breaking the truck from the clusters library, as described below.

 Defining the truck’s dynamics, as described below.

Breaking the Truck from the Clusters Library

In order to edit the truck independently of the clusters library and its other
instances, it needs to be broken (disconnected) from the clusters library, as
described below. Afterwards you will define its dynamics.

! To break the truck from the clusters library:

1. Click on the truck to select it.

2. Right-click on the truck and select Break Cluster. The truck is now
disconnected from the clusters library.

Defining Dynamics for the Truck

In the final application the truck moved from one side of the image to the
other, and back. You will now define dynamics (animation) for the truck in
this unfinished application so that it will do the same. Later, you will
simulate the application to see if the dynamics work.
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Dynamics are defined in the Dynamic Parameters dialog displayed below,
in which you can define one or more dynamics for one or more objects at
the same time.

Wizcon also enables you to define dynamics of different types for a single
object. These types are listed in the Animation area of the dialog. For
example, Fill, in which an object fills like the reactor in the complete
application, or Move 1, in which an object moves.

Each animation type has a row of fields to its left in which you enter the
required data for the dynamic.

The Animation area which
lists the animation types

The To field in which
you enter an end value

for the dynamic

The From field in which
you enter a start value

for the dynamic

The Tag  field in which
you click the arrow and
select a tag from the

drop-down list
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In this application you will define one dynamic for the truck to enable it to
move from one side of the image to the other, and back.

! To define the truck’s dynamics:

1. Right-click on the truck and select Dynamic Definition. The
Dynamic Parameters dialog is displayed:

 

Move 1 row: Enter data
in the fields to the left of
this row to define amove

dynamic for the truck

 Since you want the truck to move, fill in the fields to the left of the
Move 1 row which is a field in the list of Animation types.

2. In the Move 1 row of the Animation types, click on the arrow to the
right of the Tags field and select MOVE_TRUCK from the
drop-down list.

3. In the From field enter 1. This is the starting point of the truck.

4. In the To field enter 100. This signifies the trucks destination point.

5. Click Move 1. The dialog closes and the icon changes to a bi-
directional arrow.
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6. Click on the truck to determine its starting point.

7. Move the cursor in a straight line to the end of the screen, notice that
a diagram of the truck trails the cursor. When you have reached the
end of the screen, click to determine the end point. The Dynamic
Parameters dialog reopens.

8. Click OK to close the dialog.

Simulating the Dynamics

After defining dynamics for an object, you can simulate the application and
test it.

! To simulate dynamics:

1. From the Options menu in the image, select Simulate. The Simulate
Tag Values dialog opens:

 

2. Click on the arrow to the right of the Tag field and select
MOVE_TRUCK from the drop-down list.
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3. In the New Suggested Value field, enter 100 and click Apply to
move the truck to its determined end point.

 Re-position the truck to its starting point by opening the dialog as
described in step 1 and entering a value of 0 in the New Suggested
Value field and clicking Apply.

 or,

Move the scroll bar underneath the Tag field from one end of the
dialog to the other. Notice how the truck moves. Reposition the
truck to its starting position and click Exit.

In the next step you will define an additional zone. You will also
create an additional layer in which later you will add information
that is viewable in this layer only.
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Step 5: Defining Zones and Layers

The image now resembles the image in the final application we viewed at
the beginning of this guide. What’s left is to define the application menu
and the additional information it displayed. In order to do this we need to
add an additional zone and an additional layer to the image.

Zones

A zone is an area of an image that can be viewed in close up. An image can
consist of many zones, each representing a different part of a plant. This
application already has a zone called Overview which is active when you
view the entire application.

Layers

A layer is a specific level of an image in which additional information is
added and can only be seen in that layer. An application can consist of
many layers. This application already has a layer called Base that is active
when you first view the entire application.

Different types of plant information can be shown on different layers. For
example, the quantity of material in a reactor, as shown on page 19. This is
useful when a problem arises in a particular part of a plant. You can then
display that layer to see additional information to help you solve the
problem.
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In this step you will do the following:

•  Define a zone for the input process of the plant, as described below.

•  Define a layer and define it as the active layer so that later you can add
additional information, such as dynamic text displays and a menu
button that are visible in this layer only.

Defining a Zone

In this section you will define a zone that will represent the input process of
the plant. Defining a zone is a three stage process:

 Marking the area of the zone, as described on the following page.

 Zooming to the marked area, as described on page 51.

 Defining the zoomed area as a zone, as described on page 51.
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Marking the Area of the Zone

Using the Wizcon zoom tool you will now section off the part of the image
that represents the input process of the plant, as shown below, and view it
close up.

! To mark an area:

1. From the Options menu in the image, select Window. The cursor

changes to a .

2. Place the cursor to right of the Valve_Out, as shown below:

 
Place cursor here

3. Click and move the cursor upwards. Notice how the area is marked
with a rectangle. After you have marked the input area of the image
click again to stop marking.
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Zooming to a Marked Area

Now that you have marked off the area that will become a new zone, click
anywhere inside the green rectangle to zoom and view this area. You can
now define this area as a new zone.

Defining the Area as a Zone

You will now define this area as a zone called Input.

! To define an area as a zone:

1. From the Options menu select Zones Definition. The Zones
Definition dialog is displayed.

 

2. In the Name field, enter INPUT and click Add. The zone has been
added to the list of zones in the image.
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The dialog now appears as below:

 

3. Click Save to save your definitions in the dialog. The image now
contains two zones, the Overview zone in which the entire plant is
displayed, and the Input zone, which you now defined, in which the
part of the plant that deals with the input process is displayed.
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Defining a Layer

In this section you will define a layer in the image called Detail, and set it
as the active layer so that later you will add additional information, such as
dynamic text displays and a menu button, that is visible in this layer only.
This involves the following steps:

 Determining the scale of the layer, as described on the following
page.

 Setting the layer as the active layer, page 55.
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Determining the Scale of a Layer

You will now define the scale (zoom) range of the layer that you will call
Detail.

! To determine the scale of a layer:

1. From the Layers menu, select Definition. The following dialog is
displayed:

 

2. In the Name field, enter DETAIL.

3. In the From Scale field enter 1 to determine the zoom range’s lower
limit in which the layer is visible.

4. In the To Scale field enter 45 to determine the zoom range’s upper
limit in which the layer is visible.

5. Click Add to add the layer to the list of layers.

6. Click Save to save your definitions and to close the dialog.
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Setting the Active Layer

You will now set this layer as the active layer, so that afterward when you
create dynamic text displays and a menu button, they will be viewable in
this layer only.

! To set the active layer:

1. From the Layers menu, select Active Layer. The following dialog is
displayed:

 

2. Select DETAIL and click OK. The Detail layer is now the active
layer in the image.

In the next step you will create dynamic text displays in the Detail
layer that will display additional information viewable in this layer
only.



56  Getting Started

Step 6: Creating Dynamic Text Displays

A dynamic text display is one that has been defined to change according to
the varying value of the tags with which it has been associated. For
example, the level of material in a reactor. Its reading will reflect the level
of material in the reactor as it fills and empties.

In this step you will create dynamic text displays that can only be seen in
the Detail layer, that will display the following:

 The level of material in the storage tank.

 The level of material in the reactor.

 The run/stop status of the pump.

 The open/close status of the valves.

This is divided into the following steps:

 Creating dynamic text displays for the storage tank and the reactor,
as described below.

 Creating dynamic text displays for the pump and valves, as
described on page 60.

Creating Dynamic Text Displays for the Storage
Tank and Reactor

In this section you will create a text display for the storage tank. In the next
section you will create a dynamic text display for the reactor.
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Creating a Dynamic Text Display for the Storage Tank

You will now create a blue text display in a yellow text box to represent the
level of the material in the storage tank. This involves:

 Inserting a yellow text box from the clusters library.

 Changing the font to blue and its fill color to yellow.

 Determining the display.

! To create a dynamic text display for the storage tank:

1. From the Clusters menu of the image, select Open lib to display the
Drag&Drop to Img dialog. Click on the drop-down box in the
dialog, and select FIRSTLIB.

2. Hold down the right mouse button on the Dig_Sc_Yellow object in
the clusters library and drag and drop it on the image. Enter an
instance name of Box and click OK.

3. Click Exit to close the clusters library window.

4. Click on the box to select it, then click again and drag it to its
position on the right hand side of the storage tank.

5. In the Colors toolbox, click blue to determine the color of the font
and then right-click yellow to determine the color of the fill.

6. From the Drawings toolbox, select the Text  tool and click inside
the box. The Text dialog is displayed:
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7. Click Tag Value. The Tag Value dialog is displayed in which you
will select a tag to be associated with the text display.

 

8. Click on the arrow to the right of the Tag field and select
STORAGE from the drop-down list.

9. In the Display Mode area, make sure that DEC is selected.

10. In the Options , deselect + Prefixed, then deselect Leading Zeros.

11. In the Display Format area enter 4 in the Digits Before field and 0
in the After field.

12. Click OK to save your definitions and to close the dialog. The text
display appears in the yellow Tag Value button.

If you need to center the text display in the text box, click on the
Select  tool in the Drawing toolbox, then click on the text to
select it. Click again and drag the text into position.
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Creating a Dynamic Text Display for the Reactor

In this section you will create a blue text display in a yellow text box to
represent the level of the material in the reactor. This is similar to the text
display you have just created for the storage tank.

! To create a dynamic text display for the reactor:

1. Drag and drop the object Dig_Sc_Yellow from the clusters library as
described on page 57. Enter an instance name of Box1, click OK
and close the library.

2. Click on the box to select it, then click again and drag it to its
position on the right side of the reactor.

3. From the Drawing toolbox, select the Text  tool and click on the
box to display the Text dialog.

4. Click Tag Value to display the Tag Value dialog. In this dialog you
will define a tag to associate with the text display.

5. Click on the arrow to the right of the Tag field and select
REACTOR_LEVEL from the drop-down list.

6. Follow steps 9 through 12 on the previous page.
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Creating Dynamic Text Displays for the Pump and
Valves

In this section you will create dynamic text displays for the pump. In the
next section you will create dynamic text display for the valves.

Creating a Dynamic Text Display for the Pump

You will now create a yellow text display in a blue text box to display the
status of the pump; when the pump is open the display will read RUN, and
when it is closed the display will read STOP. This involves:

 Inserting a blue text box from the clusters library.

 Changing the font to yellow and its fill color to blue.

 Opening a pre-defined file that contains the information necessary to
create on/off buttons.

! To define a text display for the pump:

1. Drag and drop the object Dig_Sc_Blue from the clusters library as
described on page 57. Enter an instance name of Box2, click OK
and close the library.

2. Click on the box to select it, then click again and drag it to its
position underneath the pump.

3. In the Color toolbox, click yellow to determine the color of the font,
then right-click blue to determine the fill color.



Getting Started  61

4. From the Drawings toolbox, select the Text  tool and click on the
box. The Text dialog is displayed. In this dialog you will define the
text object type for the tag value.

 

5. Click Text Table. The Open Text Table File dialog is displayed.
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6. Select ON/OFF and click OK. The Text Table dialog is displayed in
which pre-defined on/off settings appear:

 

7. Click on the arrow to the right of the Tag field and select
PUMP_STAT from the drop-down list.

8. Click Save to save your definitions and to close the dialog.

Creating a Dynamic Text Display for the Valves

In this section we will show you how to create a yellow text display in a
blue text box to represent the status of the Valve_In. This is similar to the
text display you have just created for the Pump. Afterward, you will create
a text display for the Valve_Out.

! To define a text display for Valve_In:

1. Drag and drop the object Dig_Sc_Blue from the clusters library as
described on page 57. Enter an instance name of Box3, click OK
and close the library.
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2. Click on the box to select it, then click again and drag it to its
position underneath the Valve_In.

3. From the Drawing toolbox, select the Text  tool and click on the
box. The Text dialog is displayed. In this dialog you will define the
text object type for the tag value.

 

4. Click Text Table. The Open Text Table File dialog is displayed:
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5. Select ON/OFF and click OK. The Text Table dialog is displayed in
which pre-defined on/off settings appear.

 

6. Click on the arrow to the right of the Tag field and select
VALVE_IN from the drop-down list.

7. Click Save to save your definitions and to close the dialog.

Now you will define a dynamic text display for Valve_Out.

! To define a dynamic text display for Valve_Out:

1. Drag and drop the object Dig_Sc_Blue from the clusters library as
described on page 57. Enter an instance name of Box3, click OK
and close the clusters library.

2. Click on the box to select it, then click again and drag it to its
position underneath the Valve_Out.

3. Follow steps 3 through 5 on the previous page before continuing to
the next step on the following page.
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4. Click on the arrow to the right of the Tag field and select
VALVE_OUT from the drop-down list.

5. Click Save to save your definitions and to close the dialog.

Did You Know
 Wizcon enables you to have up to 64 layers in one image.

 Wizcon enables you to have up to 500 zones in one image.

 Wizcon enables you to have up to 2048 zooming scales.

In the next step you will create a button in the Input zone of the
image that can be clicked to display the entire image.
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Step 7: Creating Triggers

A trigger can be any object in an image that has been defined to execute a
specific operation whenever it is selected. For example, clicking on a
trigger-defined object can cause a predefined macro to be activated.

Wizcon has the following tag input methods that can be used for trigger
objects: Action, Buttons, Bit, Data Entry, Date, Time, and Smooth. You
will use the Action tag input method.

Creating a Trigger

In this step you will create a trigger for a button that is shown in the Input
zone of the image. When this button is clicked, it will display the entire
image. Creating this trigger will involve the following steps:

 Inserting a button from the clusters menu and positioning it, as
described below.

 Creating a text display by the button that will read Go Back, as
described on the following page.

 Defining a trigger for the button, as described on page 68.

 Re-defining the Base layer as the active layer, as described on
page 69.

Inserting a Button

Now you will insert a gray button from the clusters menu and position it in
the bottom left corner of the image. You may want to refer to the picture of
the final application shown at the beginning of this guide.

! To insert and position a button:

1. Drag and drop the object Button_menu from the clusters library as
described on page 57. Enter the instance name Box2 and click OK.
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2. Click Exit to close the clusters library

3. Click on the button to select it, then click it again and drag it to the
bottom left hand side of the image.

Creating a Text Display

Now you will create a black text display with a transparent fill for the
button that will read Go Back. This will be positioned to the right of the
button. You may want to refer to the picture of the final application as
shown at the beginning of this guide.

! To create a text display:

1. In the Color toolbox, click black and right-click the large
Transparent box on the far right of the toolbox.

2. Select the Text  tool from the Drawing toolbox and click on the
right hand side of the button. The Text dialog is displayed:

 

3. In the Text field enter Go Back and click OK to save your
definitions. The text is now displayed to the right of the button.

You may want to reposition the text by clicking the text to select it,
then clicking again and dragging it into place.
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Defining a Trigger for the Button

Now you will define a trigger for the button so that when the button is
clicked the entire image will be displayed.

! To define a trigger:

1. Click on the button to select it and then select the Trigger
Definition  tool from the Objects toolbox. The Trigger Object
Definition dialog is displayed:

 

2. Click Action. This is the tag value input method. The Action
Definition dialog is displayed.

 

3. Click the arrow to the right of the Zone field and select
OVERVIEW from the drop-down list. This is the zone that will be
displayed when the button is clicked.

4. Click OK to close the dialog.
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5. Click the Test button in the Trigger Object Definition dialog to test
the trigger. The entire image is now displayed.

6. Click OK to save your definitions and to close the dialog.

Selecting the Base Layer as the Active Layer

In Step 5, you created an additional layer called the Detail layer. You then
defined it as the active layer, the layer in which you added additional
objects viewable in that layer only. You will now re-define the Base layer
of the image as the active layer so that all other objects you define, such as
menu buttons, will be displayed when the entire image is displayed. The
Base layer is the layer that was active when you first accessed the image.

! To select the base layer:

1. From the Layers menu select Active Layer. The Select Active Layer
dialog appears.

 

2. Select Base and click OK. The Base layer is now active.

In the next step you will create a Chart that will display the level of
the material in the reactor over different periods of time.
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Step 8: Charts

Wizcon Charts provide a graphical view of a plant’s process behavior and
its operational trends over a period of time. This information is stored in the
application’s historical database and can easily be retrieved and displayed
in a Chart. A Chart can be viewed in either online or historical mode (the
default mode) to view and analyze both real-time and historical data.

You will now create an online Chart that will graphically display the level
of material in the reactor during the application process. In later steps you
will create a macro and a menu from which this Chart can be displayed.

Creating a Chart

In this section, you will create a blue-colored Chart in the Wizcon
Application Studio to display the levels of material in the reactor at
different times during the process in the application. You will then change
the default settings so that the Chart will display online information.

You will minimize the image so that you can view the studio more clearly.

! To create a Chart:

1. Minimize the image by clicking the Minimize  button in its top
right corner.

2. Click the Wizcon Application Studio  button in the taskbar at
the bottom of your screen. The Wizcon Application Studio is
displayed.

3. From the All Containers section of the Wizcon Application Studio,
right-click Charts and select New Chart.
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The following window is displayed.

 

4. From the Chart Setup menu, select Graphs Definition.
The Graphs Definition dialog is displayed:
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5. The default settings in this dialog determine that the type of Chart
will be a Line Chart. This means that the information will be
displayed in the form of lines in an X,Y type graph, as shown below.

6. Click on the arrow to the right of the Graph Color field and select
the color blue.

7. Click on the arrow to the right of the Tag field and select
REACTOR_LEVEL from the drop-down list.

8. Click Add to add the graph definitions to the list.

9. Click OK to save your definitions and to close the dialog. The Chart
is displayed:
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10. From the Modes menu of the Chart, select Online so that the Chart
will display online information. The Chart is now displayed as
follows:

 

11. From the File menu of the Chart, select Save and name the Chart
Reactor.

12. From the File menu of the Chart, select Exit to close the Chart.

 In the next step you will define an Events Summary, which is a
Wizcon window that displays the alarms in the application.



74  Getting Started

Step 9: Events Summaries

An Events Summary is a Wizcon window in which alarms are displayed.
More than one Events Summary can be created, each one can show alarms
of one type. This enables the operator to identify the alarm according to the
Events Summary in which it is displayed.

The Events Summary displays online or historical alarms that can be sorted
and filtered according to your needs.

The Events Summary displays alarms based on a range of pre-defined
criteria that are implemented when the alarm is defined. These include:

 Start time: the date and time the alarm was generated

 Ack time: the time the alarm was acknowledged by the operator

 End time: the time the alarm was terminated

 Text: the alarm message

 Severity range: the severity of the alarm

 Zone range: the area of the plant in which the alarm occurred

Creating an Events Summary

Events Summarys are created from the Wizcon Application Studio. In this
section you will create an Events Summary to display the alarm you defined
in Step 3 for the reactor.

! To create an Events Summary:

1. From the All Containers section of the Wizcon Application Studio,
right-click Events Summaries and select New Annunicator.
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An Events Summary window is displayed:

 

 The alarm will be displayed with the following criteria:

 Start time: the date and time the alarm was generated.

 Zone: the area of the plant in which the alarm was generated.

 Text: an alarm message.

2. From the Events Summary File menu, select Save and enter the
name Anno.

3. From the Events Summary File menu, select Exit to close the Events
Summary.

In the next step you will create a macro, a special shortcut, to
launch the Events Summary you defined in this step and the Chart
you defined in the previous step.
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Step 10: Macros

Macros are special shortcuts that are used to execute pre-defined actions,
commands or programs whenever designated keys or key combinations are
pressed.

Wizcon macros simplify the execution of complex operations, and enable
you to perform a series of functions with one keystroke. This enhances
Wizcon functionality and saves you the time and the effort of having to
execute Wizcon operations in several stages.

Wizcon macros include the following types: Actions, Commands, Programs
and Triggers.

Creating a Macro

In this step you will create two trigger macros: one to open the Chart you
created in Step 8 and another to open the Events Summary created in the
previous step. Both macros will be created one after the other through the
Macro Definition dialog.

! To create trigger macros:

1. From the Design menu of the Wizcon Application Studio, select
Macros.
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The following Macro Definition dialog is displayed.

 

2. Create the Chart macro:

•  In the Name field, enter the name OP_Chart.

•  In the Description field, enter the text Open Chart.

•  In the Type area, click Action. The Action dialog is displayed in
which you define a macro action.

 

 In the Actions field LoadWindow is displayed by default. If it is
not displayed click the arrow to the right of the field and select
LoadWindow from the drop-down list.
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•  Click Parameters. The Action Parameters dialog is displayed:

 

•  In the Type field, check Chr.

•  Click on the arrow to the right of the Window field, select
Reactor and click OK to save your definitions and to close the
dialog.

•  Click OK to save your definitions. The Action dialog closes.

•  In the Macro Definition (wizmacro) dialog, select Add to add
the macro to the list. The Chart macro is defined.

3. Create the Events Summary macro:

•  In the Name field, enter the name OP_Ann to define a macro for
the Events Summary.

•  In the Description field, enter the text Open Events
Summary.

•  In the Type area, click Action. The Action dialog is displayed as
shown above.

•  Click Parameters. The Action Parameters dialog is displayed as
shown above.

•  In the Type field, check Ann.

•  Click on the arrow to the right of the Window field, select Anno
and click OK to close the dialog.
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•  Click OK to save your definitions. The Action dialog closes.

•  In the Macro Definition dialog, select Add to add the macro to
the list. The Events Summary macro is defined. The Macro
Definition dialog is now displayed as follows:

 

4. Click Save to save the macros and to close the dialog.

In the next step you will create buttons for an application menu that
when clicked will launch the Chart and the Events Summary you
previously created using the macros you defined in this step.
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Step 11: Creating an Application Menu

An application menu is used to access different parts of an application, such
as Charts and Events Summarys.

In the final of the application, described in the beginning of this tutorial,
clicking the Menu  button on the image displayed the following
application menu, as described on page 19.

Each button on the application menu can be clicked to display further
information about the application. These buttons are trigger objects, objects
that when clicked upon cause a pre-defined macro to occur.

In this step you will create this application menu: This involves the
following steps:

 Inserting the gray button object from the clusters library, as
described on the following page.

 Create the Application menu; this involves creating buttons and their
trigger macros in one step, on page 82.

 Testing the buttons, on page 85.
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Inserting the Button Object

Now you will insert a gray button object from the clusters library and
position in on the bottom left hand corner of the image. You may want to
refer to the picture of the final application we described at the beginning of
this guide.

! To insert and position a button in the image:

1. Click the MY_FIRST  button in the task bar at the
bottom of your screen to display the image.

2. Drag and drop the Button_menu object from the clusters library as
described on page 57. Enter an instance name of Button and click
OK.

3. Click Exit to close the clusters library.

4. Click on the button to select it, then click it again and drag it to the
bottom left hand side of the image.
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Creating the Application Menu

Now you will create the menu buttons and their macros in one step. You
will also give the application menu the name of Menu.

! To create an Application menu:

1. Click on the gray button to select it and then select the Trigger
Definition  tool from the Objects toolbox. The Trigger Object
Definition dialog is displayed:

 

2. From the Input Method area select Buttons. The Preset Buttons
Definition dialog is displayed.
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This is the dialog in which you will define settings for the menu
buttons:

 

3. In the Title field enter Menu. This is the name of the menu that will
appear in the menu window’s title bar, as shown on page 85.

4. Create the Chart button:

•  Click on the arrow to the right of the Macro field and select
Op_Chart.

•  In the Legend field, enter the name of the button, Chart.

•  Click Add to add the button to the list.

5. Create the Events Summary button:

•  Click on the arrow to the right of the Macro field and select
Op_Ann.

•  In the Legend field, enter the name of the button Events
Summary.
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•  Click Add to add the button to the list.

6. Create the Input Zone button:

•  Clear the Macro field by clicking inside the field and pressing
the Del key.

•  Click on the arrow to the right of the Zone field and select
INPUT.

•  In the Legend field, enter the name of the button, INPUT
ZONE.

•  Click Add to add the button to the list.

7. In the Optional field select Cancel and Help. This will
automatically create Cancel and Help buttons for the menu.

8. Resize the menu buttons:

•  Click on the picture of the button in the Button Size field and
enlarge the button size a little by clicking eight times on the right
arrow key on your keyboard. This is so the buttons will be large
enough to display their text.

9. In the Style field, select Vert to display the buttons in the menu
vertically.

10. Click OK to return to the Trigger Object Definition dialog where
you can check to see if the menu works.
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11. Test the buttons:

•  Click Test in the Trigger Object Definition dialog. The
following window appears:

 

•  Click on Chart to display the Chart we created in Step 8. Close
the Chart by selecting exit from the Chart File menu.

•  Click on Cancel to close the menu.

12. Click OK to close the Trigger Object Definition dialog.

In the next step you will save your application and interact with it
just as you interacted with the final application at the beginning of
this guide.
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Step 12: Interacting w ith Your Application

After following steps 1 through 12, you have created an application that
replicates the final application we described at the beginning of this guide.
Follow the steps below to save your image and to switch it from edit mode
so that you can play with the image that you have created in this tutorial
and initiate the plant process.

! To interact with the application:

1. If you used a grid, remove it by deselecting Grid Show from the
Modes menu.

2. From the View menu, deselect the Objects, Drawings and Colors
toolboxes.

3. From the Modes menu, deselect Edit.

4. From the Modes menu select Trigger On. This will display a red
hand next to those objects that are clickable objects.

5. From the File menu, select Save.

6. Click the Wizcon Application Studio button in the taskbar at the
bottom of your screen. The Wizcon Application Studio is displayed.

7. From the File menu select Save.

Now, click on the picture to clear the Wizcon Application Studio and
refer to pages 13 through 20 to guide you through the plant process.

When you have finished interacting with your application, refer to
the next step in which you will exit Wizcon.
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Step 13: Exiting W izcon

Now that you have interacted with your application, you can exit Wizcon.

! To exit Wizcon:

1. Click on the Wizcon User name  button in the taskbar to
display the Wizcon Quick Access bar.

2. Click the Exit  icon. Wizcon closes.

Congratulations on completing your tutorial lesson! You are now
familiar with the following procedures involved in creating an
application:

 Defining a tag.

 Defining an alarm.

 Building an image by inserting objects from the clusters library, and
using Wizcon drawing tools.

 Defining dynamics to make an object move.

 Adding a zone and a layer to the image.

 Creating dynamic text displays and a trigger-defined button viewable in
one layer only.

 Creating an online Chart to display a graphical view of the plant’s
process behavior.

 Creating an Annunicator to display alarms.

 Defining trigger macros to open the Chart and Events Summary.

 Creating an application menu to access different parts of the
application.
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